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LICENSE AGREEMENT 
This software is freely distributable.  You may install the software on as many machines as you like.  You may 
make copies of the program and pass it to others.  The only restriction is that you may not make financial gain 
from the distribution of the software and you must pass a copy (either electronic or paper) of the first page of 
this manual. 

DISCLAIMER (THE LEGAL STUFF) 
 

This software is supplied ‘as is’.  Its developers provide no warranty, whether express or implied, of the 
merchantability of the software or its fitness for any particular purpose.  In no circumstances will the 
developers be liable for any damage, loss of profits, good-will or for any indirect or consequential loss 
arising out of your use of the software, or inability to use the software, even if the developers have been 
advised of the possibility of such loss. 

MAKING IT BETTER 
 

This software has been developed so that it can be used with a wide variety of clients.  If you have any 
suggestions for extending the functionality of the software, or for making it easier to use, please contact 
us at the address given below.  If you find any bugs, please pass the details on to us. 

SUPPORT 
 

This software is supplied free of charge and support is limited to the best efforts of its developers.  If you 
have problems you should contact: 
E-mail: webbie@co.umist.ac.uk 

SYSTEM REQUIREMENTS 
 

PC compatible with Windows 98, Me, 2000 and XP. 
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I N S T A L L A T I O N  

Introduction 

dWord is a simple to use, talking, symbol-word processor. It has the basic 
functionality of a word processor. EdWord can also be configured to 
produce speech and/or display text as symbols. 

The user interface of the editor can be customised so that it meets the user’s needs. 
EdWord supports user profiles so that these customisations can be saved and used 
again without having to change the settings for each different user. 
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I N S T A L L A T I O N  

Installation 

dWord can be downloaded from the Sense web site at: 
http://www.sense.org.uk/NOF 
 
 

 

Running the Installer 
1. Download the installer from the Sense web site and save it on your machine. 
 
2. When the download is complete, Setup.exe will be on your machine. This is the 

installer  
 
3. Close all running applications and run Setup.exe by double clicking on it. 

 

Actions during the Installation 
The setup program will provide a set of on-screen instructions, please follow 
these. The following sections explain some unclear instructions. 

 

Replacing Newer Files 
There are some cases where the installation tries to replace newer versions of files 
already in the system with older ones from the installer. In that case, if you are a 
Windows 98 user you might see a message like the one shown in Figure 1: 
 

 
Figure 1 

 

E 



I N S T A L L A T I O N  

Windows 98: Just click on YES to tell the installer to keep the newer version of 
the file that is in your system. The installation will resume normally. 
 
The Windows XP version of this message is shown in Figure 2 
 

 
Figure 2 

Windows XP: In this case click on NO to state that you don’t want the newer file 
to be overwritten. Again, the installation will resume normally. 

 

Restarting the System (Windows 98/Me) 
The system needs to be restarted when the installation has finished. (although, 
sometimes this might not be necessary).  However, there is a chance, during the 
last phase of the installation, that the user might be prompted to restart before the 
installation has finished. This is likely to occur on Windows 98 systems and the 
prompt looks like that shown in Figure 3 
 

 
Figure 3 

Click on NO and the installation will resume normally updating the system 
settings and it will finally ask you to restart the system, as shown in Figure 4 
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Figure 4 

 
Click OK to restart the system and complete the installation. 
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Quick Start 

fter installing EdWord  you can run it by clicking the Start button, then 
Programs, then Sense, then EdWord and EdWeb and then EdWord 
 
EdWord will now run and you should see the screen shown in Figure 5. 

 

 

Figure 5 

Start with Default settings 
To start using EdWord click on the Log On button situated at the bottom of the 
window. The program will start with the default settings and you can start typing your 
document. Alternatively, you can click on Close or the X button at the top of the 
window to exit the program. You can also choose the Add User tab to manage the 
users of the system, this is explained later. 

A 



Q U I C K  S T A R T  

The Editor Window 
When starting with default settings, the editor is shown in Figure 6. 

 

Figure 6 

The window can be logically divided into four sections: The menu, the toolbar, the 
main document body and the grid. You can start typing right away and almost every 
word you type will be converted to symbol1. You can explore the menu and toolbar 
options by yourself but for a more detailed explanation please read the Step By Step 
section of the manual. 

                                                                            

1 Provided you have installed/created a symbol set (see Page 18) 
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Step By Step – User Management 

n this section, we will look at the creation, deletion and configuration of users. 

 

Getting Started 
From the logon screen, click on the Add User tab. You will see the screen shown in 
Figure 7. 

 

Figure 7 

This gives three options: 

• Add a user. This will add a user to the list of users and create a new folder 
which will contain the user’s documents. You can select the new user from the 
list and log on as this new user. 

• Remove a user. Use this option when you want to delete the selected user. 
When you click on Remove, a new window will ask you for confirmation of 
deletion. The (Default) user cannot be deleted. Any other user can be deleted. 
Note: When deleting a user, the documents that were saved in the user’s 

I 
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folder will be deleted as well.  See later for information about how to keep 
documents after a user has been deleted. 

• Configure a user. This option will show a new window which will help you to 
configure the selected user. 

Adding Users 
To add a user, type a user name and click on Add - see. Figure 8 

 

Figure 8 

 This will result in the creation of a folder with the same name as the username under 
the ‘Users’ folder in the installation directory. For example, when Add is clicked, John 
will be added on the list and at the same time a new folder will be created in: 
C:\Program Files\Sense\EdWord\Users\John.  The user name will appear in the 
Existing Users list – see Figure 9. 
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Figure 9 

Deleting Users 
When you click on Remove, you will see the window shown in Figure 10: 

 

Figure 10 

Type the word: delete in the box and the OK will be enabled – see Figure 11.  
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Figure 11 

Click on OK to delete the user. You can click Cancel if you do not want to delete the 
user. We think this confirmation method will help in avoiding accidental deletions. 

As noted earlier, when deleting a user, the user’s folder is deleted. This results in the 
deletion of all the documents created by this user. If you need to delete a user and save 
the documents, documents can be saved manually from C:\ProgramFiles\Sense\ 
EdWord\Users\User Name.  They can be later copied into a user directory and will 
appear as documents of that user. 

Configuring Users 
When you click on Configure, you will see the window in Figure 12.  This window is 
divided into three sections:  

1. Level Selection. Here you can select the level of user interface complexity. 
There are three predefined levels: Level 1, Level 2, Level 3 and there is a 
fourth level: Level C which allows you to set the user interface complexity as 
it suits the users. The default for new users is Level 1 (basic features) 

2. Level Configuration. This area has a list of check boxes which state whether 
a feature should be present or not in the user interface. For Levels 1 to 3 these 
features cannot be changed. Only in Level C users can select any of these 
features. 

3. General Settings. This section controls other general settings of the editor 
such as the default font, menu font, colours, voice, symbol settings and initial 
grid. 
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Figure 12 

Level Selection 
You can set the user interface level of complexity by selecting one of the four 
options of the list – see Figure 13. 
 

1. Level 1 loads the editor with the basic features. 
2. Level 2 introduces some more advanced features and 
3. Level 3 has all the features enabled. 
4. Level C lets you customise the user interface complexity.  

 
Note: A feature that is enabled in a lower level will also be enabled in a higher 
level. 
 

Level Selection 

Level Configuration 

General Settings 
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Figure 13 

Level Configuration 
When you select Level C, the checkboxes are enabled and you can now select 
features by checking or un-checking a box – see Figure 14. 
 
The following list explains each feature: 
 

1. Loading and Saving EdWord Documents: This option will allow the 
user to Open and Save EdWord documents. These features are available 
from the File menu and the toolbar. 

2. Grid Support: This option allows the user to use grids. The grid is 
displayed under the document body in the editor window. Grids are 
explained later. 

3. Printing: This option allows the user to print the documents. Printing can 
be accessed from the File menu and the toolbar. 

4. Bold Italic Underline font settings: This option allows the user to 
change the font style. This can be done by clicking on icons on the 
toolbar. 
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5. Font Selection: By checking this option, the user can select among three 
fonts: Times New Roman, Arial and Courier New. The font size can 
also be adjusted as well. These options are available from the Format 
menu and the toolbar. 

6. Paragraph Alignment: This option allows the user to set alignment of 
the paragraph to Left, Centre, Right and Justified. This feature can be 
found on the toolbar. 

7. Clipboard operations (Copy, Cut and Paste): This option allows the 
user to copy cut and paste a selection. The three commands can be found 
under the Edit menu 

8. Voice Settings: This option gives access to voice settings from the editor. 
The Voice Settings can be found under the Settings menu.  This option 
is explained in detail later. 

9. Colour Selection: This option allows the user to change the background 
and font colours of the document. It can be found under the Format 
menu and is explained in detail later. 

 

 
Figure 14 
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Figure 15 shows where you can find each feature 

 

 

Figure 15 
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General Settings 
Here (see Figure 16) you can change the general settings of the Editor.  

 

Figure 16 

The list below explains the options: 

1. Set Default Font: Here you can set the default font of the editor (This 
setting as well as the other settings affect only the selected user). You can 
select a front and its size. 

2. Presentation: Here you have three options 

a. Symbols and Text: when the user types a word, a symbol appears 
over that word. 

b. Symbols Only: when the user types a word, the word is replaced 
by the symbol  

c. Text Only: Words are not converted to symbols. The user can 
type normally as in a regular word processor. 

Note: If there are no symbol sets installed, Text Only will be the only 
available choice. 

3. Set Document Colours: This button will bring up the dialog box (Figure 
17) which will help you set the document colours. The same dialog box 
can be accessed by clicking Colours under the Format menu in the editor 
(You have to enable Colour Selection from the Level Configuration for 
this to apply). To set the font colour make sure the Fonts option is 
selected in the Apply To... list and then select a colour. To set the 
background colour, select the Background option in the Apply To... list 
and select the background colour. You can see what your document will 
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look like in the Preview pane. To accept changes click on OK. To discard 
changes click on Cancel. 

 

Figure 17 

4. Voice Options: This button will bring up a dialog box (Figure 18) that 
will help you set the voice settings for the editor. The same dialog box can 
be accessed by clicking Voice under the Settings menu in the editor 
environment. (You have to select Voice Settings from the Level 
Configuration first). 

You can select a voice from the voice list by clicking on it. You can adjust 
the Pitch, Speed and Volume from the sliders and click on the Test 
button to listen to your settings. From the Speech Options you can 
enable or disable a set of features: 

a. Speak characters as you type: If this feature is enabled, when the 
user types a character, the voice you selected will speak that 
character. This feature is turned off by default. 

b. Speak words as you type: if this feature is enabled, as soon as the 
user types a word followed by space, enter or tab, the selected 
voice will say that word. 

c. Speak when using arrow keys: When this feature is enabled, the 
user can use the arrow keys from the keyboard to move around 
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the document and listen to what is at the current position. When 
moving left and right letters are spoken. When pressing CTRL and 
moving left and right words are spoken. When moving up and 
down the whole line is spoken.  

d. Speak words when clicked: This feature allows the user to click 
on a word/symbol and have it spoken by the selected voice. 

e. Turn speech off: This options turns speech off when selected and 
none of the above features has any effect. 

You can accept the settings by clicking on OK or discard them by clicking 
on Cancel. 

 

Figure 18 

  

5. Choose Symbol Set: Clicking on this button will bring up the symbol set 
selection dialog box (Figure 19). This dialog lets you select which symbol 
set to use for converting words to symbols when the document 
Presentation is set to Symbols and Text or Symbols Only.   

To do that select the name of the symbol set you want to use from the list, 
and press OK to apply the new settings and return to the previous dialog. 
You may press Cancel at any time to close this dialog without changing 
the currently selected symbol set. You must have at least one symbol set 
installed on your system in order to use this option. You can create your 
own symbol sets with Symbol Set Wizard, also available from the Sense 
web site. For more information on how to create symbols please refer to 
the Symbol Set Wizard user manual. 
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Figure 19 

6. Menu Fonts: Clicking on this button will bring up the font selection 
dialog box (Figure 20). This dialog lets you set the font in which the menu 
will be displayed. To do that: 

 

1. Select a font from the Font list 

2. Select a font style from the Font Style list 

3. Select a size from the size list between 10 and 36 

4. Click OK to accept changes or Cancel to discard them 

 

The default menu font is Arial size 22 
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Figure 20 

 

7. Select Initial Grid: Clicking on this button will bring up the Grid 
selection dialog box (Figure 21). This dialog box displays a list of grids 
installed on the system. You can select one of the grids in the list and see 
what it looks like in the preview. To set an initial grid: 

a. Select it by selecting its name in the list 

b. Press OK to close the dialog and set the new initial grid 

c. Alternatively, press Cancel to close the dialog without changing 
the current initial grid 
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Figure 21 

This completes the User Management section of Step By Step. You can now 
create users and change their settings according to their needs. If you have any 
problems refer to this section. 
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Step By Step – Word Processing  

n this section we will take a look at the editor environment. We will go through 
the menu items and the toolbar buttons. 

 

The editor environment 
We will talk about Level 3 configuration to cover all the features of the editor 
environment. Everything covered here applies to other user interface levels as well. 

When you Log On with a Level 3 user, you have access to all the features of EdWord. 
We can divide this window (Figure 22) into three parts: Menu, Toolbar and 
Document Body. 

 

Figure 22 

The Document Body 
We will start with the Document Body as this is the where the user mainly interacts 
with the program. When the user types a character from the keyboard, it appears in the 
Document Body. Depending on the settings, as the user types, symbols appear over 

I 
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Toolbar 

Document Body 
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the words or even replace them. The text is displayed in the default font which has 
been set from the General Settings (explained in User Management Section) 

The Toolbar 
The toolbar provides access to File Management and Document Formatting 
features. Thus, we can divide the toolbar into two parts (Figure 23). 

 

Figure 23 

The File Management buttons provided by the toolbar are (in order of 
appearance): 
 

1. New: Creates a new document. If the current document has changed 
since the last save or has not been saved at all, the user is prompted to 
save the changes with this message (Figure 24) 

File Management 

Document 
Formatting 
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Figure 24 

If No is selected the new document is created without saving the changes 
in the current document. If Cancel is selected, the dialog closes and 
returns to the current document without creating a new document. If Yes 
is selected, the current document is saved and a new document is created. 
Rules that apply to Save are explained in 3. Save (below).  

2. Open: This button asks the user to save the current document if it needs 
to be saved (explained above) and shows the dialog box in (Figure 25) : 

 

Figure 25 

This dialog lists all of the logged on user’s documents (in this example, John’s). Select a 
file from the list (by clicking on it) and click OK. If you wish to return to the current 
document without opening a file, click on Cancel. 
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3. Save: This button saves the current document. If the document has not 
been saved before, the user is prompted to give a name under which the 
file will be saved (see Figure 26). 

 

Figure 26 

If the document has been saved before or opened from an already existing 
file, the changes are saved on that file without having to enter a document 
name again.  

4. Print: This button prints the document at the default printer on an A4 
page. 

 
The Document Formatting buttons provided by the toolbar are (in order of 
appearance): 

1. Bold Italic Underline: These three buttons change the font style to 
Bold Italic and Underline. You can click on one or more of these 
buttons and the next character you type will be displayed with the 
selected style combination. 

2. Paragraph Alignment buttons: This button allows you to align your 
text in four different ways. 

a. Align Left aligns the text to the left. Text extends from left to 
right as you type 

b. Centre, centres the text in the document body 
c. Align Right aligns the text to the right. As you type the text 

extends from right to left. 
d. Justify spreads the text so that, lines extend from left to right 

evenly. 
3. Font selection buttons: These three buttons allows the user to 

change the font. Just press on: 
a. T for Times New Roman 
b. A for Arial 
c. C for Courier New 
d. The dropdown list to select the size of the font 
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The Menu 
The menu provides all of the functionality found in the toolbar plus some extra 
commands. On a Level 3 user configuration the menu is shown in Figure 27. 

 

Figure 27 

The File Menu is shown in Figure 28: 

 

Figure 28 

As you can see most of the options are available from the toolbar. The only new 
option is Log Off. Log Off asks the user to save the document, closes the editor 
environment and shows then logon screen. 
 
The Edit Menu provides clipboard operations. Here the user can Cut, Copy, and 
Paste a selection. Clipboard is a “place in memory” where data is temporarily saved 
for later use. You can select text and symbols by holding down the Shift key and 
pressing an arrow key or by pressing the mouse button on a word and without 
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releasing the mouse button moving the mouse to select text. The Edit menu is 
shown in Figure 29. 

 

Figure 29 

There are three standard clipboard operations in this menu: 

1. Cut: This option removes the selection from the document body and 
places it in the clipboard. 

2. Copy: This option copies the selection to the clipboard without removing 
it from the document body. 

3. Paste: This option copies the contents of the clipboard to the current 
input position (indicated by the caret – blinking vertical line) in the 
document body. The clipboard contents are not deleted. (i.e. you can paste 
again without having to copy the same things because they are already in 
the clipboard) 

The Format menu (Figure 30) helps you change the visual aspects of your 
document. From this menu you can change the Fonts and the Colours of the 
document. 

 

Figure 30 

This menu has two options 
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1. Font: this option will bring up the window shown in Figure 31. 

 

Figure 31 

Here you can select one of the three fonts and the size for that font. You 
can check the preview panel to see what it looks like.  Click OK to accept 
the changes or Cancel to discard the changes. 

2. Colours: This option allows you to change the Font and background 
colours of the document body. For more information refer to General 
Settings in the User Management Section (Page 16). 

The Settings Menu has only one item and is shown in Figure 32. 

 

Figure 32 

The Voice option will show the voice settings window. For more information 
refer to General Settings in the User Management Section (Page 16).  

Note: Any changes made to the Fonts, Colours and Voice settings from the 
menu, will not be saved in the user profile. If you want to make changes and save 
them, do it from the General Settings in the User Configuration.  

This concludes the Step By Step – Word Processing Section of the manual
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Problems 

In this section, we will try to answer any questions you might have during your  
first contact with EdWord. 

 

Q. When I try to change the default font in the general settings, I only have 
three options: Arial, Times New Roman and Courier New. Why can’t I see 
the rest of the fonts installed on my system? 

A. This is because we think that we should only support a limited set of fonts. We 
chose Arial because it is the clearest font, Times New Roman because it is 
frequently used in word processors and Courier New because it is a fixed width 
font (all the letters have the same width). 

Q. I cannot hear any sound. 

A. Make sure the Turn speech off option is unchecked and the speakers of your 
system are properly connected and switched on. Also check the volume of the 
speakers and the volume of Windows. 

Q. The menu is not displayed in the font I selected. 

A. Some fonts whose script is other than Western might not be displayed on the 
menu. In that case the menu is displayed in Arial 

Q. I cannot set the menu font size to a size greater than 36. 

A. This is because there is a limit in the menu font size. Bigger fonts make the menu 
very large and there is no room for the document body. 

Q. When I open a document, the words are not converted to symbols. 

A. Make sure the user’s presentation mode is set to Symbols or Symbols and Text, 
otherwise words will not be converted to symbol. 

I 


